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1 Nyheter

Nyheter
Nyheter i version 5.4.0 för programvaran TI-SmartView™ CE
TI-SmartView™ CE 84 Plus CE-T Nyheter

• TI-84 Plus CE-T standard emulatortillstånd uppdaterat.

- OS version 5.4.0
- Appen EasyData version 5.3.6 (smärre fix)
- Appen Transformation Graphing version 5.3.1 (smärre fix)
- Appen TI-Innovator™ Hub App version 5.4.0 (meny-uppdateringar)

För mer information om de nya och uppdaterade funktionerna, gå till referensguiden
för TI-84 Plus CE på education.ti.com/84ceupdate.

TI-SmartView CE för familjen TI-84 Plus

Uppdatera till den senaste programvaran på education.ti.com/84ceupdate för
förbättringar och CE-emulator med senaste räknarfiler för den här releasen.

https://education.ti.com/84ceupdate
https://education.ti.com/84ceupdate


Introduktion till TI-SmartView™ CE-programvaran
Med TI-SmartView™ CE-programvaran kan du visa en TI-grafräknare för hela
klassrummet. Två arbetsområden är tillgängliga för att hjälpa dig att förbättra dina
presentationer i klassrummet.

Arbetsområdet Räknaremulator

Här kan du:

• Visa en Full Emulator-skärm eller en Knappsats
med stor skärm. Med alternativa vyer för att
öppna eller stänga.

• Tangenttryckningshistorik
– Visar bilder av nedtryckta tangenter så att

elever kan följa med i tangenttryckningarna.
• View3™

– Lärarkontrollerad uppdatering av upp till tre
ytterligare emulerade skärmar såsom Graf,
Tabell och Ekvation för flera
representationer.

• Beräkna och plotta
– Samma upplevelse som på en fysisk

grafräknare.
• Dra och släpp en emulerad skärm till din

programvara för klasspresentation.**
– Bygg ut dina lektioner med skärmar som

skapats under din undervisning.
• Tryck på emulatortangenter med en

Fjärrknappsats!
– Kör SmartPad™ CE-appen*** på din TI-84

Plus CE ansluten till datorn med din USB-
kabel. När fönstret TI-SmartView™ CE är i
fokus på din dator blir din räknare en
Fjärrknappsats.

• Öppna ett separat Screen Capture-fönster
– Infånga och spara emulatorskärmar som

datorfiler liknande TI Connect™ CE Screen
Capture, som infångar skärmbilder från
grafräknaren.

** Programvara såsom Microsoft™ Office eller annan presentationsprogramvara
stöds.
***Appen SmartPad™ CE för TI-84 Plus CE kommer förladdad på räknaren. Om inte
appen SmartPad CE finns på din TI-84 Plus CE, så finns den även tillgänglig för
nedladdning till din räknare från education.ti.com/84ceupdate.
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3 Introduktion till TI-SmartView™ CE-programvaran

Obs: Skärmen Large Display är inte pekaktiverad. Använd emulatortangenter som på
räknaren.

Skärmen Räknaremulator



Arbetsområdet Emulatorutforskare

Här kan du:

• Lägg till enstaka eller flera filer till emulatorn för inställning inför dina
lektioner:
– Dra valda räknarfiler och/eller dina bilder (jpg, png, etc.) från din

dator till emulatorn för snabb emulatorinställning även under
lektioner.

• Spara filer från emulatorn för att spara till eller dela med dina
elevräknare:
– Dra valda räknarfiler till din dator för att spara filer från en

klasspresentation.
– Tips: När filerna har sparats till din dator kan du dra dessa filer till

anslutna elevräknare med TI Connect™ CE Calculator Explorer för
klassrumsdelning. TI Connect™ CE är fri för nedladdning från
education.ti.com/downloads.

Standardskärmen Emulatorutforskare

Introduktion till TI-SmartView™ CE-programvaran 4



5 Använda arbetsområdet TI-SmartView™ CE Räknaremulator

Använda arbetsområdet TI-SmartView™ CE
Räknaremulator
Arbetsområdet TI-SmartView™ CE Räknaremulator innehåller verktyg som du kan
använda för att mata in beräkningar, plotta variabler och visa grafer, tabeller och listor.



Områden i fönstret TI-SmartView™ CE Software

Menyfält - Använd dessa menyer för att utföra alla emulatorfunktioner, inklusive:

• File (Arkiv) - filhantering • Actions (Åtgärder) - såsom infånga skärm
• Edit (Redigera) - inkludera

kopiera tangent som
typsnitt

• Help (Hjälp) - Hjälp och länkar

• View (Visa) - ändra
skärmarna

Anmärkning: Du kan utföra de flesta åtgärder på dessa menyer genom att klicka
på ikoner i verktygsfältet.

Verktygsfält - Använd dessa verktygsikoner för att:
• Välja en annan räknarmodell
• Växla visning av Stor skärm, Knapptryckningshistorik På eller Av samt View3™
• Infånga aktuell emulatorskärm

Arbetsområdespanel - Använd denna panel för att navigera mellan
arbetsområdena Calculator Emulator (Räknaremulator) och Emulator Explorer
(Emulatorutforskare).

Välj positioner för Emulator och Verktygsfält

• Emulatorposition vänster/höger - för att växla mellan vänster- och
högerhandsvisning av grafräknarens skärm. Detta är praktiskt vid projicering
av en interaktiv skrivtavla.

• Verktygsfält topp/botten - för att flytta verktygsfältet mellan skärmens
över- och underdel. Detta är praktiskt vid projicering av en interaktiv
skrivtavla.

Obs: Du kan ändra den visuella layouten och/eller positionen för element för att
optimera åtkomsten, särskilt när du använder en interaktiv skrivtavla.

Emulatorpanel - Använd denna panel för att använda denna fulla emulatorvyn
eller endast emulatorknappsatsvyn.

Stor skärm / Knapptryckningshistorik - Använd denna panel för att visa en stor
räknarskärm och/eller visa knapptryckningshistorik.
Du har följande visningsalternativ:

• Large Display Screen only
(Endast Stor skärm)

• Key Press History only (Endast
Knapptryckningshistorik)

• Large Display Screen + Key Press
History (Stor skärm +
Knapptryckningshistorik)

• Hide panel (Dölj panel)

Använda arbetsområdet TI-SmartView™ CE Räknaremulator 6



7 Använda arbetsområdet TI-SmartView™ CE Räknaremulator

View3™-panel - Använd denna panel för att samtidigt visa ytterligare tre

skärmar. (Som förinställning är denna panel dold. Klicka på för att visa
View3™-panelen.)
Du kan välja tre av följande skärmar:

• Equation (Ekvation
("Y="-editor))

• List (Lista)
(Stat List-editor))

• Window
(Fönster)

• Table (Tabell) • Stat Plot
(Statistikplottning)

• [Blank]
([Blank])

• Graph (Graf)

Ändra storlek på Paneler - Klicka på och dra den vertikala listen på sidan av en
panel för att ändra dess storlek.



Använda tangentbordet i TI-SmartView™ CE Emulator
Musen ersätter ditt finger vid tangenttryckningar på datorns tangentbord.

Klicka på tangenterna på TI-SmartView™ CE-emulatorn på samma sätt som du skulle
trycka på tangenterna på grafräknaren.

1. Klicka på piltangenterna på emulatorns tangentbord för att flytta markören
till önskad plats.

2. Klicka på för att välja den.
Du måste först ställa in tangentbordet i alfabetiskt skrivläge för att skriva text med
datorns tangentbord.

Som förinställning är grafräknarens tangentbord i sitt normala läge, vilket innebär att
tangenterna helt enkelt är kortkommandon för grafräknarens tangenter.
Att till exempel trycka på [A] på din dators tangentbord är detsamma som att klicka på

på grafräknaren. I detta läge kan du inte skriva in bokstäverna A till Ö på
grafräknarens skärm genom att skriva dessa bokstäver på datorns tangentbord.

För att skriva in en bokstav eller annat alfatecken, klicka först på på
grafräknarens tangentbord (eller tryck på [F7] på datorns tangentbord) för att ställa
räknaren i alfaläge. Om du till exempel skriver [F7] [A] på datorns tangentbord så
skrivs ett A in på grafräknarens skärm. När du har skrivit in tecknet återgår
tangentbordet till sitt normala läge.

Du kan låsa alfatangenten för att skriva flera tecken i följd.

För att låsa alfatangenten:

▶ Klicka på på grafräknarens tangentbord eller tryck på [F6] [F7] på
datorns tangentbord.

För att återgå till normalläget:

▶ Klicka eller tryck på [F7].

Att i alfaläge trycka på [0] till [9] på datorns tangentbord fungerar som
kortkommandon för de alfafunktioner som är associerade med dessa tangenter på
grafräknarens tangentbord. Trycker du på [1] så skrivs Y (alfatecknet associerat med
À) in på grafräknarens skärm. För att skriva in ett tal, se till att tangentbordet inte är i
alfaskrivläge. Dessa tangenter skriver in siffrorna 0 till 9 i normalläget.

Använda arbetsområdet TI-SmartView™ CE Räknaremulator 8



9 Använda arbetsområdet TI-SmartView™ CE Räknaremulator

Du kan hålla ned en piltangent för att kontinuerligt bläddra med markören.

När du använder en piltangent för att flytta markören kan du hålla tangenten nedtryckt
för att utan uppehåll flytta markören i stället för att trycka på tangenten upprepade
gånger. I tangenttryckningshistoriken och i ett skript har symbolen för en upprepande

piltangent en klocksymbol fäst vid sig

När du trycker på en piltangent flera gånger i rad visas en pil med en
repetitionsräknare.

När du trycker på en piltangent flera gånger i rad visas en piltangent i

knapptryckningshistoriken. Denna piltangent, , har ett nummer fäst vid den som
visar hur många gånger piltangenten har tryckts ned.

Tips: När du spårar längs grafer, eller använder applikationen Cabri™ Jr App för att rita
geometriska former, kan du med pilarna på datorns tangentbord få en jämnare rörelse
jämfört med att använda en mus för att klicka på emulatorpilarna.

Dra och släppa en skärm till en annan applikation
Du kan dra och släppa och klistra in valfri skärm i TI-SmartView™ CE i en annan
applikation.

Skärmarna i TI-SmartView™ CE som du kan dra och klistra in inkluderar följande:

• Skärmen ovanför tangetbordet i Emulatorpanelen

• Stor skärm

• Skärmar i View3™-panelen

Obs: Du kan dra en View3™-skärm till Screen Capture och använda Screen Capture
som en historik över viktiga skärmar under en lektion.

• Sparade och ej sparade infångade skärmbilder



Ansluta en räknare som en fjärrknappsats
Appen SmartPad™ CE är tillgänglig för TI-84 Plus CE. För att använda
TI-84 Plus CE som en fjärrknappsats för TI-SmartView™ CE:

1. Appen SmartPad™ CE för TI-84 Plus CE kommer förladdad på räknaren. Om inte
appen SmartPad CE finns på din TI-84 Plus CE, så finns den även tillgänglig för
nedladdning till din räknare från education.ti.com/84ceupdate.

2. Anslut din TI-84 Plus CE till datorn med en USB-datorkabel som medföljde din
räknare.

3. Starta TI-SmartView™ CE. Se till att TI-SmartView™ CE-fönstret är aktivt genom att
klicka på TI-SmartView™ CE-fönstret.

4. Kör appen SmartPad™ CE på din TI-84 Plus CE. Tryck på [apps] och välj SmartPad™
CE på Apps-menyn. Läs informationen på skärmen.

5. Tryck på tangenterna på räknarens knappsats som fjärrstyr emulatorns tangentbord
på TI-Smartview ™ CE.

6. Koppla loss USB-kabeln från räknaren för att stoppa appen och funktionen för
fjärrknappsats.

7. Du kan behöva ansluta USB-kabeln och köra appen på nytt om anslutningen för
fjärrknappsatsen inte längre svarar.

Anmärkning:

• TI-84 Plus CE som kör appen SmartPad™ CE visar inte beräkningar eller grafer.
Räknaren fungerar då enbart som en fjärransluten USB-knappsats för emulatorn.

• TI-84 Plus CE förblir en fjärrknappsats när fönstret TI-SmartView™ CE är aktivt.
Klicka på TI-SmartView-fönstret innan du trycker på räknarens tangenter.

• TI SilverLink-kabeln stöds ej i TI-SmartView™ CE.

USB-datorkabel

Du måste använda USB-datorkabeln som medföljer din TI-84 Plus CE grafräknare för
att använda appen SmartPad™ CE. Andra TI-anslutningskablar stöds ej.

Använda arbetsområdet TI-SmartView™ CE Räknaremulator 10
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11 Använda arbetsområdet TI-SmartView™ CE Räknaremulator

Ytterligare information om anslutningsmöjligheter

• Menyn Emulator Link - Ingen sändning/mottagning

Link-funktionen,y8 på emulatorerna är avaktiverad. För att länka filer mellan
en ansluten räknare och en emulator, använd Calculator Explorer i TI Connect™ CE
och Emulator Explorer i TI-SmartView™ CE.

Dra först räknar- eller emulatorfiler till datorn vid överföring mellan Emulator
Explorer i TI-SmartView™ CE och Calculator Explorer i TI-Connect™ CE.

• TI-SilverLink-kabel

TI SilverLink-kabeln stöds ej i TI-SmartView™ CE.

• Återställa en räknare från TEST MODE (testläges)inställning

TI-SmartView™ CE överför inte en fil till en ansluten räknare.

För att avsluta inställningen PROVLÄGE, använd ett av dessa sätt.

- Anslut en CE-T-räknare till TI Connect CE version 5.4.0 eller högre
- Välj Actions > Quit Exam Mode on Connected CE Calculators (Åtgärder > Avsluta

provläge på anslutna CE-T-räknare).
- Skicka en fil mellan två räknare.
- Anslut till TI Connect CE version 5.4.0 eller högre och skicka en fil till en

ansluten/anslutna räknare



Återställa emulatorn
För att återställa emulatorn:

1. Klicka på Actions (Åtgärder).

2. Klicka på Reset Emulator (Återställ emulator).

3. Klicka på Reset (Återställ).

Återställa emulatorn:

• Skriver över emulatorns aktuella status

• Återställer TI-SmartView™ CE-programvaran till fabriksinställningarna

• Rensar tangenttryckningshistoriken

Uppdatera emulator-OS

Om det i framtiden finns en OS-uppdatering för en CE-räknare men TI-SmartView CE-
emulatorn inte uppdateras så kan emulatorn uppdateras med Actions (Åtgärder) >
Update Emulator OS… (Uppdatera emulator OS….
TI-SmartView CE kräver en särskild emulatortillståndsfil för att uppdatera emulator-
OS. Den finns på education.ti.com/84ceupdate. Denna fil är annorlunda jämfört med
filen du använde för att uppdatera räknarens OS.

Använda arbetsområdet TI-SmartView™ CE Räknaremulator 12
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13 Använda arbetsområdet TI-SmartView™ CE Räknaremulator

Spara och läs in en CE-emulator Status
När du sparar ett CE-emulatortillstånd skapas en fil som lagrar emulatorns
inställningar med alla ändringar som du har gjort.

Du kan till exempel förbereda en klasspresentation genom att mata in funktioner i
"Y="-editorn och ändra inställningarna för Fönster och Zoom. När du sparar dina
ändringar i en emulatortillståndsfil kan du helt enkelt läsa in filen för att visa
presentationen. Om du vill skapa olika presentationer för olika klasser kan du skapa
flera tillståndsfiler för emulatorn.

Obs: Historik för tangenttryckningar, skärmdumpar och emulatorns storlek sparas inte i
emulatorns tillståndsfil. Observera att tillståndsfilen för CE-emulatorn kan vara stor.
Kontakta IT-avdelningen om lagringskapaciteten är ett problem för dig.

Spara CE-emulatortillståndet

Att hantera, spara och läsa in en fil för emulatortillståndet är endast tillgängligt för CE-
emulatorn. TI-84 Plus CE-emulatortillståndsfil kan endast läsas in på TI-84 Plus CE-
emulator.

1. Klicka på Actions (Åtgärder) > Save Emulator State... (Spara emulatortillstånd...).

2. I dialogrutan:

a) Navigera till den mapp där du vill spara CE-emulatorns tillståndsfil.
b) Skriv in ett filnamn. Använd ett namn som beskriver CE-emulatorns tillstånd.



CE-emulatortillståndsfilen har ett förkonfigurerat filnamn TI84PCE Emulator State_
OS x-x-x_date.s84 där filtillägget, *.s84 indikerar att filen är ett TI-84 Plus CE
emulatortillstånd skapad med TISmartView™ CE-programvaran.

c) Klicka på Save (Spara).

Läsa in ett CE-emulatortillstånd

Eftersom CE-emulatortillståndsfilerna är specifika för varje räknarmodell kan du endast
läsa in en emulatortillståndsfil för den aktiva räknarmodellen.

1. Klicka på Actions (Åtgärder) > Load Emulator State (Läs in emulatortillstånd).

2. I dialogrutan:

a) Navigera till den mapp som innehåller emulatorns tillståndsfil.

Obs: Endast CE-emulatortillståndsfilerna för den aktiva räknarmodellen visas.

b) Klicka på namnet på CE-emulatorns tillståndsnamn för att markera filen.
c) Klicka på Open (Öppna).
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15 Använda arbetsområdet TI-SmartView™ CE Räknaremulator

Välja ett visningsalternativ
Du kan anpassa ditt visningsfönster så att det visar eller döljer tillvalspaneler och ändra
typen av information som visas i dem. Som förinställning visar TI-SmartView™ CE-
programvaran räknaremulatorns arbetsområde i läget Large Screen (Stor skärm).

Visa räknarskärmen

1. Klicka på för att visa
räknarskärmen ovanför
tangetbordet i
Emulatorpanelen.

2. Klicka på för att visa skärmen
Knappsats + Stor skärm.

Välja en emulatortyp

Klicka på nedåtpilen på för att välja en emulatortyp.



Varje emulatortyp visar dess relevanta räknarmodell.

Byta räknarens framstycke

För att byta framstycket:

1. Klicka på View (Visa).

2. Håll markören över Calculator Faceplate (Räknarframstycke).

3. Klicka på namnet på ett räknarframstycke.

Ljus Kontur Mörk
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17 Använda arbetsområdet TI-SmartView™ CE Räknaremulator

Visa eller dölja tangenttryckningshistoriken

Klicka på för att visa eller dölja tangenttryckningshistoriken.
Klicka på CLEAR (RENSA) i panelen intill tangenttryckningshistoriken för att rensa
historiken.

Klicka här och dra för att ändra
storleken på
tangenttryckningshistorikens
panel.

Klicka här för att rensa
tangenttryckningshistoriken.

När du trycker på CLEAR ser du denna informationsruta:

Kopiera tangenttryckningshistoriken till en annan applikation
Du kan kopiera alla eller utvalda delar av tangenttryckningshistoriken till en annan

applikation, t.ex. en ordbehandlare. Du kan kopiera tangentgrafik såsom den
visas i tangenttryckningshistoriken eller också kan du kopiera tangenttryckningar som
typsnittstecken·¹¸.

Anmärkning: När du kopierar tangenter som typsnittstecken använder dessa tecken
teckensnittet TI84PlusCEKeys. Detta typsnitt installeras automatiskt i din dator när du
installerar TI- SmartView™ CE-programvaran.

Kopiera tangenter som grafik- eller typsnittstecken

1. Välj den eller de tangenter som du vill kopiera.
För att välja tangenter i tangenttryckningshistorikens panel använder du en av
följande metoder:

Knapp Metod
– En enda tangent: Klicka på en tangent.



Knapp Metod
– Flera tangenter: Klicka på en tangent.

Håll Ctrl-tangenten nedtryckt på
datorns tangentbord.
Klicka sedan på andra tangenter för att
välja fler.

– Flera tangenter i sekvens: Klicka på en tangent.
Tryck och håll Shift-tangenten
nedtryckt på datorns tangentbord.
Tryck på en annan tangent.
Obs: Du kan härigenom välja de två
tangenterna plus alla tangenter
mellan dem.

– Alla tangenter: Klicka på en tangent.
Högerklicka.
Klicka på Select All (Välj alla).

Anmärkning: Så här ser en tangent ut före och efter att du har valt den.

Före: Efter:

2. Högerklicka på de valda tangenterna.

3. Klicka på Copy (för att kopiera tangenter som grafik).

- eller -

Klicka på Copy As Font (för att kopiera tangenter som typsnittstecken).·¹¸.

4. Växla till en annan applikation.

5. Klistra in tangenterna på lämplig plats.

Obs:

• Du kan också dra de valda tangenterna som grafik till den andra applikationen.

• Du kan ändra storleken på tangentgrafiken när du har klistrat in dem i en ny
applikation.

• I vissa applikationer kan tecken inklistrade som typsnitt visas med det typsnitt som
används på den aktuella platsen. Då kanske de inte alls ser ut som
grafräknartangenter. Vid behov, ändra till typsnittet TI84PlusCEKeys på tecknen. Se
hjälpfilen för målapplikationen du använder för information om hur du tillämpar
ett typsnitt på tecknen.

Använda arbetsområdet TI-SmartView™ CE Räknaremulator 18



19 Använda arbetsområdet TI-SmartView™ CE Räknaremulator

Visa panelen View3™

1. Klicka på för att visa View3™-panelen.
2. Klicka på titelfältet på varje skärm för att välja mellan dessa visningsalternativ:

– Ekvation
("Y="-
editor)

– Lista
(Stat List-editor)

– Fönster

– Tabell – Statistikplottning – [Blank]
– Graf

3. Klicka i den gröna, lärarkontrollerade uppdateringsknappen i View3™-panelen för
att uppdatera View3™-skärmarna. Detta uppdaterar vyn för dina elever under
undersökningar.

Uppdatering detekterad Uppdaterar eller avbryt Ingen uppdatering detekterad

4. Visa innehållet på de valda skärmarna, eller upprepa steg 2 för att ändra skärmtyp.



Ändra storlek på TI-SmartView™ CE-skärmen
Klicka på och dra kanten på en panel för att ändra storleken på panelerna Emulator,
Large Display (Stor skärm) eller panelen View3™.

Anmärkning: Alla dessa är vänster/högeråtgärder med undantag för
tangenttryckningshistoriken som är dra upp eller dra ned.

Positioner för emulator och verktygsfält
Emulatorposition vänster/höger - för att växla mellan vänster- och
högerhandsvisning av grafräknarens skärm. Detta är praktiskt vid
projicering av en interaktiv skrivtavla.

Verktygsfält topp/botten - för att flytta verktygsfältet mellan skärmens
över- och underdel. Detta är praktiskt vid projicering av en interaktiv
skrivtavla.

Alltid överst
Välj detta alternativ (Alltid överst) på View-menyn för att hålla TI-SmartView™ CE-
fönstren över andra öppna datorprogramvarufönster. Detta är som att ha räknaren
liggande på skrivbordet ovanpå dina papper! Placera fönstret på ditt datorskrivbord där
det bäst upprätthåller "Always in Front".

För att stänga av "Alltid överst," välj menyobjektet på View-menyn. Det finns ingen
verktygsikon för denna funktion och ingen indikator utöver menykryssmarkeringen när
funktionen är aktiv.

Obs:

Använda arbetsområdet TI-SmartView™ CE Räknaremulator 20
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Arbetsområdet TI-SmartView™ CE Emulator och Screen Capture-fönster kommer båda
att vara "Alltid överst" och växlar beroende på deras position.

"Alltid överst" rekommenderas inte när du har full skärmbild eftersom alla andra
fönster kommer att vara bakom den fulla skärmbilden av TI-SmartView™ CE.



Använda Skärmdump
Du kan infånga den aktuella grafräknarens skärmbilder med TI-SmartView™-
emulatorns Screen Capture-verktyg.

För att använda funktionen Capture Screen:

▶ Klicka på i verktygsfältet.

Detta fönster öppnas:

Använda Skärmdump 22
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Områden i fönstret Screen Capture

Infånga Klicka här för att infånga en bild av emulatorskärmen:
Actions (Åtgärder) > Capture Screen (och Capture Screen)
Anmärkning: En ram visas automatiskt runt varje skärmbild
när du infångar den, men du kan ta bort ramen genom att
klicka på View > Hide Screen Capture Borders (Visa> Göm
Screen Capture Borders). (Om du har flera bilder tar detta
bort ramen runt varje bild.)
Med Screen Capture kan du:
• infånga upp till 44 skärmbilder åt gången (för att infånga

ytterligare bilder, ta bort bilder från fönstret Screen
Capture).

• automatiskt lagra infångade skärmbilder i minnet tills du
stänger huvudfönstret i TI-SmartView™ CE.

När du stänger Screen Capture uppmanas du att spara dina
infångade skärmbilder. Du kan starta en ny Screen Capture-
session under en TI-SmartView™ CE-session.

Spara Klicka här för att spara valda infångade skärmbilder:
File > Save As(Arkiv > Spara som)

Kopiera Klicka här för att kopiera valda infångade skärmbilder till
klippbordet:
Edit > Copy (Redigera > Kopiera)

Ta bort Klicka här för att ta bort valda infångade skärmbilder:
File > Delete (Redigera> Ta bort)

Ändra storlek För punkten längs skalan för att justera storleken i
granskningen av den aktuella infångade skärmbilden.
View > Scale Screen Captures (Visa> Skala Screen Fångar)
Obs: Skärmar sparas för den aktuella procentsatsen i vyn.

Ändra namn Ändra namnet på en infångad skärmbild genom att markera
titeln och skriva in ett nytt namn.

Visa Visa infångade skärmbilder här.

Dra och släppa en skärm till en annan applikation
Du kan dra och släppa och klistra in valfri skärm i TI-SmartView™ CE i en annan
applikation.

Skärmarna i TI-SmartView™ CE som du kan dra och klistra in inkluderar följande:

• Skärmen ovanför tangetbordet i Emulatorpanelen

• Stor skärm

• Skärmar i View3™-panelen

Obs: Du kan dra en View3™-skärm till Screen Capture och använda Screen Capture
som en historik över viktiga skärmar under en lektion.



• Sparade och ej sparade infångade skärmbilder
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Använda arbetsområdet TI-SmartView™ CE
Emulatorutforskare
Från arbetsområdet Emulatorutforskare kan du hantera emulatorfiler, lägga till
innehåll från din dator till emulatorn och skicka valt innehåll till din dator.



Delar av huvudfönstret TI-SmartView™ Emulator Explorer

Lägga till räknarfiler från dator till emulator.

Skicka valda räknarfiler till dator.

Ta bort valda räknarfiler.

Uppdatera vyn över emulatorns innehåll.
Obs: När du ändrar arbetsområdet till Emulator Explorer, uppdatera vyn
av emulatorfilerna för att uppdatera eventuella ändringar som gjorts i
emulatorn.

Kopiera emulatorfiler till datorn
Du kan kopiera de flesta data, filer och program från din emulator till din dator som
backup-filer och sedan skicka dessa till andra räknare eller för att frigöra minne i
emulatorn.

Kopiera en fil från emulatorn till datorn

1. Klicka på filnamnet för att välja det.

2. Klicka på .

- eller -

Dra och släpp filen i en mapp i din dator eller på ditt skrivbord.

Kopiera en fil från datorn till emulatorn

1. Klicka på .
2. Navigera till önskad räknarfil i din dator.

Obs: Du kan också dra dina bilder (.jpg, .png, etc.) för att konvertera till
emulator/räknarbakgrundsbilder.

3. Klicka på filen för att välja den.

4. Klicka på Open (Öppna).

Ta bort emulatorfiler
Du kan ta bort data, filer och program från din emulator.

Ta bort filer från emulatorn

1. Klicka på filnamnet för att välja det.
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2. Tryck på .

Kortkommandon på tangentbord
Du kan använda din dators tangentbord för att trycka på en tangent i stället för att
trycka på den tangenten på TI-SmartView™ CE-tangentbordsbilden.

Till exempel:

Om du vill öppna "log"-funktionen på emulatorns tangentbord, använd tabellen nedan
för att hitta vilken datortangent du ska trycka på.

▶ Tryck på [N] på din dators tangentbord (och observera att emulatortangenten
upptill till vänster är alfabokstaven N.)

Obs! I vissa fall visas tangenten på emulatorn när du på tangentbordsknappen på
datorn. Ikonen Knapptryckningshistorik kanske inte visas förrän vid nästa
knapptryckning.
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Kompatibilitet med grafräknare
Se handboken Komma igång med din TI-84 Plus CE för kompatibilitet med grafräknare.

Anmärkning: I regel är grafräknarna TI-84 Plus CE kompatibla med andra TI-84 Plus- och
TI-83 Plus-modeller.

Appar, operativsystem och vissa datafiler med numeriska typer som ej stöds delas inte
mellan modeller.

TI-Basic-program kan behöva modifieras för att korrekt visa högupplösta
färgskärmsmodeller.



Datainsamling med appen Vernier EasyData® på
emulatorn för TI-84 Plus CE
Med appen Vernier EasyData® CE kan du använda datainsamling på emulatorn för TI-
84 Plus CE. Appen Vernier EasyData® CE för TI-84 Plus CE är förinstallerad på
emulatorn i TI-Smartview ™ CE. Med appen kan du samla in enstaka sensordata på
liknande sätt som med räknarens app.

Tips:

• Se till att du är bekant med datainsamling med appen EasyData® på räknaren
innan du använder TI-SmartView™ CE för att samla in data.

• Se till att du är bekant med menyn (File>New) för appen EasyData® CE eller
kortkommandot Scan. Du kommer att använda dessa funktioner i emulatorn för att
ansluta en sensor till emulatorn medan sensorn är ansluten till datorn.

Använda Vernier-sensorer med TI-Smartview ™ CE och appen
EasyData® CE
Om du redan använder Vernier-sensorer med TI-84 Plus CE eller med produktfamiljen
TI-8x med en mini USB-port, kan sensorerna anslutas till räknarens mini USB-port.

Vernier-sensorer som ska användas med produktfamiljen TI-8x (mini USB) behöver rätt
adapter för att ansluta en vanlig USB-kontakt till datorn för att demonstrera
datainsamling.

Adaptrar

Sensortyp som ska anslutas till datorn

Namn Adapter Beskrivning

Easy to Go! Använd denna adapter för anslutning av
EasyTemp eller EasyLink™-adapter till en dator
för datainsamling. Semer

Go!Link Använd denna enkanals gränssnittsadapter för
att ansluta de flesta av Vernier-sensorerna till
datorn. Semer

Go!Motion
till
datorkabel

Använd denna kabel för att ansluta Go!Motion
eller CBR 2 till en dator. Den medföljer
Go!Motion. Semer

Datainsamling med appen Vernier EasyData® på emulatorn för TI-84 Plus CE 30
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Sensortyp som ska anslutas till räknaren

Namn Adapter Beskrivning

EasyLink™ Använd denna adapter för att länka Vernier-
sensorer till grafräknaren TI-84 Plus CE.
EasyLink™ är ett enkanals gränssnitt som ansluts
till USB-porten på grafräknaren TI-84 Plus eller
handenheten TI-Nspire™. Semer

Go!to Easy
Adapter
(miniUSB)

Använd denna adapter för att ansluta Go!Temp
eller Go!Link™* till USB-porten på handenheten
TI-Nspire™ eller grafräknaren TI-84. Semer

Go!Motion
till räknarens
miniUSB-
port

Använd denna 72-tums kabel för att ansluta en
Go!Motion eller CBR 2 till USB-porten på
handenheten TI-Nspire™ eller grafräknaren TI-
84. Kabeln har en USB-kontakt av typ mini-A
som ansluts till räknaren och en vanlig USB-
kontakt av typ B som ansluts till Go!Motion eller
CBR 2. Kabeln medföljer CBR 2. Semer

Vid användning för klassrumsdemonstrationer

Datainsamling med appen EasyData® stöds för klassrumsdemonstrationer endast på
emulatorn för TI-84 Plus CE . Om din klass använder någon räknare ur produktfamiljen
TI-8x med den senaste versionen av appen Vernier EasyData®, kommer
demonstrationen av datainsamling med hjälp av TI-SmartView™ CE med TI-84 Plus CE
att vara jämförbar med upplevelsen på TI-8x-räknaren.

Datainsamling från en sensor

Datainsamling från en enda sensor stöds i emulatorn för TI-84 Plus CE (liknande
räknaren TI-84 Plus CE).

Om sensorn stöds av appen EasyData® App på räknaren via mini USB-kontakten, blir
emulatorn i TI-Smartview ™ CE ett demonstrationsverktyg för datainsamling som liknar
upplevelsen på räknaren.

• CBR 2™ (Calculator-Based Ranger™) stöds med USB-kabeln.

• CBL 2™ (Calculator-Based Laboratory™ system) stöds inte.

• Den senaste versionen av appen Vernier EasyData® CE för TI-84 Plus CE är
förinstallerad i emulatorn.

• Äldre versioner av appen är blockerade i Emulator Explorer för att få den bästa
upplevelsen av datainsamlingen.

http://www.vernier.com/products/interfaces/ez-link/
http://www.vernier.com/products/accessories/usb-mini/
http://www.vernier.com/products/accessories/ti-gmusb/


Använda TI-SmartView™ CE för att demonstrera datainsamlingen
1. Starta TI-SmartView™ CE.

Tips: Om du kör någon annan programvara som också samlar in data med hjälp av
Verniers USB-sensorer, rekommenderar vi att du stänger alla andra
datainsamlingsprogram så att TI-Smartview ™ CE känner igen den valda sensorn
för denna datainsamling. Annars kommer din dators operativsystem att
”bestämma” vilken sensor som ska kännas igen. Du kanske inte ser din sensor som
ansluten till TI-SmartView™ CE förrän du stänger andra program.

2. Klicka på nedåtpilen på för att välja en emulatortyp.

3. Anslut en sensor till datorn via en vanlig USB-port.

Avancerade funktioner: Du kan ha flera sensorer anslutna till dina datorportar. Du
kan använda menyalternativet (Actions>Select Data Collection Sensor) i TI-
SmartView™ CE för växla mellan sensorerna. Använd menyn (File>New) på appen
EasyData® CE för att ansluta nya sensorer till emulatorn.

4. Kör appen EasyData® på emulatorn för TI-84 Plus CE.

OBS: Den senaste versionen av appen Vernier EasyData för emulatorn för TI-84 Plus
CE (version 5.2 eller högre) är förinstallerad i TI-SmartView™ CE (v 5.2 eller högre).

5. EasyData® startar på emulatorn. Du bör se namnet på sensorn (eller
länkanslutningen) på välkomstskärmen. Sensornamnet visas sedan i mätarskärmen
på ett liknande sätt som i räknaren.

Om appen EasyData® inte känner igen den anslutna sensorn till datorn kan du
använda antingen Scan eller File>New i appen EasyData® på emulatorn för att
ansluta sensorn.

6. Använd funktionerna i appen EasyData® App på samma sätt som med CE-
emulatorn för att samla in och analysera data.

7. Avsluta appen (QUIT) EasyData® i emulatorn när datainsamlingen är genomförd för
att fortsätta använda TI-SmartView™ CE.

• Data från datainsamlingen lagras i emulatorns listor när du avslutar appen
EasyData® CE.

• Du kan låta sensorn vara ansluten till datorn så länge du behöver.
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Medan appen EasyData® CE körs på CE-emulatorn kan du göra följande:

Byta
arbetsyta på
emulatorn

Du kan byta emulator medan EasyData® körs men
dataexperimentet stoppas och sensorn kopplas bort från
CE-emulatorn som kör appen EasyData®. När du återgår till
CE-emulatorn, kommer du att få ansluta sensorn på nytt
till appen EasyData® CE med antingen File>New eller
kortkommandot Scan i appen EasyData® och påbörja en ny
datainsamling. Det är inte säkert att föregående
experiments data lagras. Avsluta alltid appen EasyData®
med QUIT för att lagra experimentdata till emulatorns
listor.

View3™ och
appar

View3™ är inte tillgänglig (avaktiverad) för alla appar
förutom appen Inequality Graphing.
View3™ visar endast skärmar från operativsystemet ™ och
visar inte app-skärmar. Vi rekommenderar att du behåller
View3™ stängd när du inte använder funktionen eller då
den är avaktiverad som när de flesta appar körs på
emulatorn.

Byta till
arbetsytan
Emulator
Explorer

Om EasyData® körs i CE-emulatorn och du behöver
använda Emulator Explorer, avsluta då först appen
EasyData® och använd därefter Emulator Explorer.

Infånga
skärmbilder

Du kan infånga skärmbilder från appen EasyData® under
tiden som ett experiment utförs med Screen Capture.

Stäng och
öppna på
nytt
TI-
SmartView™
CE

Du kan stänga TI-SmartView™ CE medan EasyData® körs
men dataexperimentet stoppas och sensorn kopplas bort
från CE-emulatorn som kör appen EasyData®. När du
återgår till CE-emulatorn, kommer du att få ansluta
sensorn på nytt till appen EasyData® CE med antingen
File>New eller kortkommandot Scan i appen EasyData® och
påbörja en ny datainsamling. Det är inte säkert att
föregående experiments data lagras. Avsluta alltid appen
EasyData® med QUIT för att lagra experimentdata till
emulatorns listor.

Ytterligare hjälp

Om du behöver mer hjälp med att använda appen EasyData® med räknaren för att
samla in data, finner du mer information i
http://www2.vernier.com/manuals/easydata_guidebook.pdf.

http://www2.vernier.com/manuals/easydata_guidebook.pdf


Allmän information
Onlinehjälp
education.ti.com/eguide

Välj ditt land för mer produktinformation.

Kontakta TI-support
education.ti.com/ti-cares

Välj ditt land för tekniska- och andra supportresurser.

Service- och garantiinformation
education.ti.com/warranty

Välj ditt land för information om garantins längd och villkor eller om produkttjänsten.

Begränsad garanti. Denna garanti påverkar inte dina lagstadgade rättigheter.

Uppdateringar
education.ti.com/84ceupdate
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